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Introduction

A double Gauss lens is a multiple element objective lens commonly used in imaging
systems. It is capable of high quality imagery over moderately large field angles, at modest
to high speed. In this tutorial, a double Gauss lens model (Figure 1) is constructed using
multiple instances of standard parts from the built-in Part Library for the Ray Optics
Module. The results of a ray trace will be presented together with a spot diagram and a

wavefront aberration diagram.

;

Figure 1: Overview of the double Gauss lens used in this tutorial. In this view the marginal
rays of an on-axis trace ave shown, together with the chief ray of 4 additional fields.

Model Definition

The double Gauss lens simulated in this tutorial is an f/1.7, 100.2 mm focal length, 19°
field of view lens by Lautebacher & Brendel (Agfa Camera Werk Ag, U.S. Patent
2784643), from Ref. 1, p. 323. The prescription of this lens is given in Table 1 and the
instructions for creating the lens can be found in the Appendix — Geometry Instructions.

The lens geometry is created by inserting each lens element (including the stop)
sequentially, such that each subsequent lens is placed relative to the prior one. This process

is simplified by making use of the predefined work planes within the part instances. It is
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important to appreciate that the ray tracing method used by the Geometrical Optics
interface is inherently nonsequential, so the same result could be obtained by placing part
instances within the geometry in any order. The double Gauss lens geometry sequence is

shown in Figure 2 and the default, Physics-controlled mesh, is seen in Figure 3.

In addition to the lens parameters used to define the lens geometry, a set of parameters are
required to define the ray trace. These are detailed in Table 2.

TABLE |: DOUBLE GAUSS LENS PARAMETERS.

Index Name Radius Thickness Material Clear radius
(mm) (mm) (mm)
— Object oo oo — —
| Lens | 75.050 9.000 LaF3 33.0
— — 270.700 0.100 — 33.0
2 Lens 2 39.270 16.510 BaFl 1 27.5
3 Lens 3 oo 2.000 N-SF5 24.5
— — 25.650 10.990 — 19.5
4 Stop oo 13.000 — 18.6
5 Lens 4 -31.870 7.030 N-SF5 18.5
6 Lens 5 oo 8.980 LaF3 21.0
— — —43.510 0.100 — 21.0
7 Lens 6 221.140 7.980 BaFl | 23.0
— — —88.790 61.418 — 23.0
— Image oo — — 42.5

TABLE 2: GLOBAL PARAMETER DEFINITIONS.

Parameter Value Description

Avac 550 nm Nominal (vacuum) wavelength

6, 0° Nominal x field angle

0, 0° Nominal y field angle

Niing 18 Number of hexapolar rings. (Nying = 18 will give
a total of 1027 rays.)

Poom 58.941 mm Nominal entrance pupil diameter

Peoc1 -1.15 Pupil shift factor |

Py —-0.60 Pupil shift factor 2
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Figure 2: The double Gauss lens geometry sequence.
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Figure 3: The default Physics-controlled mesh for the double Gauss lens.
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Several of the parameters defined in Table 2 are used to derive additional parameters such
as the ray direction vector components, the stop and image plane z-coordinates, as well as
the entrance pupil location. Table 3 gives the expressions used to derived these parameters.
Note that the pupil shift factor is used in a empirical approximation to ensure that the chief

ray passes through the center of the stop at all field angles.

TABLE 3: GLOBAL PARAMETER DEFINITIONS (DERIVED).

Parameter Value Description

Uy tan®, Ray direction vector, x-component

vy tan@, Ray direction vector, y-component

v, 1 Ray direction vector, z-component

Zstop Stop z-coordinate, where T , is the central

3 thickness of element n and T, is the
DT, ,+T,) )
e en separation between elements n and n+1.
Note that the stop is the 4th element in the
double Gauss lens.

Zimage . Image plane z-coordinate, where T, , is the
Z (T. +T.) central thickness of element n and T, is the
oper o separation between elements n and n+l.

B Including the stop, the double Gauss lens has
7 elements.
P P o1 + Ppaeo SinO
fac facl ™ Hfac2 Pupil shift factor, where 6 = /63 + 9y2
Axpupil (Azpypil + Pac Zstop)tan®,  Pupil shift, x-coordinate
AYpupil (Azpupil + Prac Zstop)tan®y,  Pupil shift, y-coordinate

Results and Discussion

A ray trace has been made at a single wavelength (550 nm) and field angle (on-axis). In
Figure 4 the ray trajectories can be seen colored by optical path length and in Figure 5, a

color expression based on the location of the rays at the image plane is used.

Spot diagrams at both the nominal and refocused image plane are shown in Figure 6. The
refocused spot diagram in Figure 6 uses an Intersection Point 3D dataset which has been
automatically positioned on the plane which minimizes the RMS spot size. At this
wavelength and field angle, this plane is located 187 pwm ahead of the nominal image

surface.

Figure 7 shows the wavefront error. After removing piston and defocus, it is possible to
see that spherical aberration dominates the remaining terms.
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Figure 4: Ray dingram of the donble Gauss lens colored by optical path length.
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Figure 5: Ray diagram of the double Gauss lens where the rays ave coloved by their radial
distance from the centroid on the image plane.
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Figure 6: Spot diagram for the double Gawss lens. The spot on the nominal image plane is on
the left, and the spot on the “best focus” plane is seen on the right.

Wavefront error Wavefront error

T T T T T T T T T T
141 B
1.2 B
1+ .
0.8 B
0.6 B
0.4 B
0.2 B
2= of 4
>
0.2 B
-0.4 B
06 ,
08| i
1k i
-l.21 B
1.4 B
1 ! ! ! ! 1 1 1 1 1
-1 -0.5 2 25 3 35
v 217 A 122
-2 0.5 1

Figure 7: The double Gauss lens optical aberration diagram. The plot on the left uses all
Zernike terms. On the right, piston and defocus are removed.
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Reference

1. W.J. Smith, Modern lens design, vol. 2. New York, NY, USA: McGraw-Hill, 2005.

Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
double_gauss_lens

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click iw 3p.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click e Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.
6 Click [V] Done.

GLOBAL DEFINITIONS

Parameters |: Lens Prescription
I In the Model Builder window, under Global Definitions click Parameters I.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in
the Label text field. The lens prescription will be added when the geometry sequence is

inserted in the following section.

Parameters 2: General
The double Gauss lens simulation parameters can be loaded from a text file.

I In the Home toolbar, click Pi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2: General in the Label text
field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_parameters.txt.

COMPONENT I (COMPI)

I In the Model Builder window, click Component | (compl).

2 In the Settings window for Component, locate the General section.

3 Find the Mesh frame coordinates subsection. From the Geometry shape function list,
choose Cubic Lagrange. The ray tracing algorithm used by the Geometrical Optics
interface computes the refracted ray direction based on a discretized geometry via the
underlying finite element mesh. A cubic geometry shape order usually introduces less

discretization error compared to the default, which uses linear and quadratic
polynomials.

DOUBLE GAUSS LENS

Insert the prepared geometry sequence from file. You can read the instructions for creating
the geometry in the appendix. Following insertion, the lens definitions will be available in
the Parameters node.

I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, type Double Gauss Lens in the Label text field.
3 In the Geometry toolbar, click Insert Sequence.
4

Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom_sequence.mph.

[, ]

In the Geometry toolbar, click [§§ Build All.
6 Click the 'I]]= Orthographic Projection button in the Graphics toolbar.

7 Click the ]‘:_; Go to ZY View button in the Graphics toolbar. Orient the view to place the
z-axis (optical axis) horizontal and the y-axis vertical. Compare the resulting geometry
to Figure 2.

MATERIALS

Load the materials used by each of the lenses.

ADD MATERIAL

I In the Home toolbar, click £37 Add Material to open the Add Material window.
2 Go to the Add Material window.
3 In the tree, select Optical>Glasses>Optical Glass: Hoya>Hoya LAF3.

4 Click Add to Component in the window toolbar.
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5 In the tree, select Optical>Glasses>Optical Glass: Hoya>Hoya BAFI I.

6 Click Add to Component in the window toolbar.

7 In the tree, select Optical>Glasses>Optical Glass: Schott>Schott N-SF5.
8 Click Add to Component in the window toolbar.

9 In the Home toolbar, click 37 Add Material to close the Add Material window.

MATERIALS

Hoya LAF3 (matl)
I In the Model Builder window, under Component | (compl)>Materials click
Hoya LAF3 (matl).

2 In the Settings window for Material, locate the Geometric Entity Selection section.
3 From the Selection list, choose Lens Material 1.

Hoya BAFI | (mat2)

I In the Model Builder window, click Hoya BAFI I (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.
3 From the Selection list, choose Lens Material 2.

Schott N-SF5 (mat3)

I In the Model Builder window, click Schott N-SF5 (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 3.

GEOMETRICAL OPTICS (GOP)

I In the Model Builder window, under Component 1 (compl) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation

section.

3 In the Maximum number of secondary rays text field, type 0. In this simulation stray light

is not being traced, so reflected rays will not be produced at the lens surfaces.

4 Seclect the Use geometry normals for ray-boundary interactions check box. This ensures
that geometry normals are used to apply the boundary conditions on all refracting
surfaces. This is appropriate for the highest accuracy ray traces in single-physics

simulations, where the geometry is not deformed.

5 Locate the Material Properties of Exterior and Unmeshed Domains scction. From the
Optical dispersion model list, choose Air, Edlen (1953). It is assumed that the double

Gauss lens is surrounded by air at room temperature.
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6 Locate the Additional Variables section. Select the Compute optical path length check
box. The optical path length will be used to create an Optical Aberration plot.

Medium Properties |
I In the Model Builder window, under Component | (compl)>Geometrical Optics (gop) click

Medium Properties |.
2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material.
Each of the materials added above contain the optical dispersion coefficients which can

be used to compute the refractive index as a function of wavelength.
Material Discontinuity |
I In the Model Builder window, click Material Discontinuity 1.
2 In the Settings window for Material Discontinuity, locate the Rays to Release section.
3 From the Release reflected rays list, choose Never.
Ray Properties |
I In the Model Builder window, click Ray Properties 1.
2 In the Settings window for Ray Properties, locate the Ray Properties section.
3 In the A text field, type lambda. This wavelength is defined in the Parameters node.
Release from Grid |
Release the rays from a hexapolar grid, using the quantities defined in the Parameters node.
I In the Physics toolbar, click #2% Global and choose Release from Grid.
2 In the Settings window for Release from Grid, locate the Initial Coordinates scction.
3 From the Grid type list, choose Hexapolar.

4 Specity the q, vector as

dx x
dy y
dz 2z

The Center location of the hexapolar grid will change according to the field angle.
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5 Specify the r, vector as

nix x
niy y
niz z

The Cylinder axis direction is the same as the global optical axis.
6 In the R, text field, type P_nom/2.
7 In the N, text field, type N_ring.

8 Locate the Ray Direction Vector section. Specify the Ly vector as

VX X
vy y
vz

The Ray direction vector is calculated using the field angles defined in the Parameters
node.

Obstructions

I In the Physics toolbar, click mw Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.
4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.
Stop

I In the Physics toolbar, click mw Boundaries and choose Wall.

2 In the Settings window for Wall, type Stop in the Label text field.

3 Locate the Boundary Selection scction. From the Selection list, choose Aperture Stop.
4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.
Image

I In the Physics toolbar, click mw Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection scction. From the Selection list, choosc Image Plane. The

default Wall condition (Freeze) will be used.
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MESH 1

In the Model Builder window, under Component | (compl) right-click Mesh 1 and choose
Build All. The default physics-controlled mesh settings can be used in this simulation. The
mesh should look like Figure 3.

STUDY |
Step I: Ray Tracing
I In the Model Builder window, under Study I click Step I: Ray Tracing.
In the Settings window for Ray Tracing, locate the Study Settings section.

2
3 From the Time-step specification list, choose Specify maximum path length.
4 From the Length unit list, choose mm.

5

In the Lengths text field, type 0 200. The maximum optical path length is sufficient for

rays released at large field angles to reach the image plane.

6 In the Home toolbar, click = Compute.

RESULTS
In the following steps, two different ray diagrams are created, one of which uses a custom
color expression. Begin by making some modifications to the default ray trajectory plot.

First, define a cut plane which can be used to render the double Gauss lens cross-section.

Cut Plane |
In the Results toolbar, click @ Cut Plane.

Ray Diagram |

I In the Model Builder window, under Results click Ray Trajectories (gop).

2 In the Settings window for 3D Plot Group, type Ray Diagram 1 in the Label text field.
3 Locate the Color Legend section. Select the Show units check box.

4 From the Position list, choosc Bottom.

5 In the Model Builder window, expand the Ray Diagram | node.

Filter |

I In the Model Builder window, expand the Results>Ray Diagram |>Ray Trajectories |
node, then click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.
3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at (0,abs(gop.deltagx) <
0.1[mm]). Only the sagittal rays are shown in this view.
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In the following steps, the cross-section of the lens is rendered.
Surface |
I In the Model Builder window, right-click Ray Diagram | and choose Surface.
2 In the Settings window for Surface, locate the Data section.
3 From the Dataset list, choose Cut Plane 1.
4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.
5 From the Color list, choose Gray.
Line |
I Right-click Ray Diagram | and choose Line.
In the Settings window for Line, locate the Data section.
From the Dataset list, choose Cut Plane 1.

2
3
4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.
5 From the Color list, choose Black.

6

In the Ray Diagram | toolbar, click Plot. Compare the resulting image to Figure 4.

Ray Diagram 2

For the second ray diagram the rays will be colored according to the radial distance from
the ray’s location in the image plane to the centroid. This makes it possible to visualize
which rays are contributing to the image plane spot aberrations.

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Ray Diagram 2 in the Label text field.
3 Locate the Data section. From the Dataset list, choose Ray 1.

4 Locate the Plot Settings section. From the View list, choose New view.

5 Locate the Color Legend section. Select the Show units check box.

Ray Trajectories |
In the Ray Diagram 2 toolbar, click r. More Plots and choose Ray Trajectories.

Color Expression |
I Right-click Ray Trajectories |1 and choose Color Expression.
2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel). This is the radial coordinate
relative to the centroid of each release feature at the image plane.

4 From the Unit list, choose pm.
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Surface |
I In the Model Builder window, right-click Ray Diagram 2 and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.
3 From the Coloring list, choose Uniform.

4 From the Color list, choose Custom.
5

On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.

6 Click Define custom colors.

7 Set the RGB values to 54, 140, and 203, respectively.

8 Click Add to custom colors.

9 Click Show color palette only or OK on the cross-platform desktop.
Selection |

I Right-click Surface | and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Lens Exteriors.

Transparency |

I In the Model Builder window, right-click Surface | and choose Transparency.
2 In the Ray Diagram 2 toolbar, click Plot.

3 Click the 'I]]= Orthographic Projection button in the Graphics toolbar.

4 Click the Zoom Extents button in the Graphics toolbar. Orient the view to match

Figure 5 so that the color expression in the object plane can be clearly seen.

Spot Diagram
In the following steps, a spot diagram is created.

Spot Diagram

I In the Home toolbar, click @1 Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.
3 Locate the Color Legend section. Select the Show units check box.

4 From the Position list, choosc Bottom.

Spot Diagram |

I In the Spot Diagram toolbar, click . More Plots and choose Spot Diagram.

2 In the Settings window for Spot Diagram, click to expand the Annotations section.
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3 Sclect the Show spot coordinates check box.

4 From the Coordinate system list, choose Global. Using the Global coordinate system
allows the z coordinate to be displayed.

5 In the Display precision text ficld, type 6.

Color Expression |

I Right-click Spot Diagram | and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at (0, gop.rrel). This is the radial coordinate relative

to the center at the location of the ray release.

The first spot diagram shows the intersection of the rays with the nominal image plane.
This surface has been positioned so as to give the best image quality over a large range of
field angles when using polychromatic light. A second spot diagram can be generated

automatically on the plane which minimizes the RMS spot size for a selected field angle

and wavelength.

Spot Diagram 2

O N o un

In the Model Builder window, under Results>Spot Diagram right-click Spot Diagram | and
choose Duplicate.

In the Settings window for Spet Diagram, click to expand the Focal Plane Orientation
section.

From the Normal to focal plane list, choose User defined. In this model, the image plane
is assumed to be tangential to the optical axis which is also the z-axis.

Click Create Focal Plane Dataset. This creates an Intersection Point 3D dataset on a Plane.
In this model, which has a single on-axis field and monochromatic light, the location of
the best focus plane happens to be in front of the nominal image surface. If the best
focus plane lies behind the image plane, then the Freeze condition on the Wall defining
the Image surface should be disabled. Note that the focal plane is located 187 microns
in front of the nominal image surface.

Click to expand the Pesition section. In the x text field, type 0.25.

Click to expand the Inherit Style section. From the Plot list, choose Spot Diagram 1.

In the Spot Diagram toolbar, click Plot.

Click the Zoom Extents button in the Graphics toolbar. Compare the resulting
image to Figure 6.

Optical Aberration Diagram

In the following steps, an optical aberration diagram is created.
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Optical Aberration Diagram

|
2

4

In the Home toolbar, click @1 Add Plot Group and choose 2D Plot Group.

In the Settings window for 2D Plot Group, type Optical Aberration Diagram in the
Label text field.

Locate the Color Legend section. Select the Show maximum and minimum values check
box.

From the Position list, choose Bottom.

Optical Aberration |

5

In the Optical Aberration Diagram toolbar, click . More Plots and choose
Optical Aberration.

In the Settings window for Optical Aberration, locate the Focal Plane Orientation scction.

From the Normal to focal plane list, choose User defined. As with the Spot Diagram, the
image plane is assumed to be tangential to the optical axis which is also the z-axis.

Click Create Reference Hemisphere Dataset. This creates an Intersection Point 3D dataset

on a reference hemisphere.

Locate the Coloring and Style section. Select the Reverse color table check box.

Optical Aberration 2

NV O N 0 1 AW N

Right-click Optical Aberration | and choose Duplicate. Duplicate this Aberration plot so

that some Zernike terms can be removed.

In the Settings window for Optical Aberration, locate the Zernike Polynomials section.
From the Terms to include list, choose Select individual terms.

Click Select All.

Clear the Z(0,0), piston check box.

Clear the Z(2,0), defocus check box. The piston and defocus terms are removed.
Locate the Position section. In the x text field, type 2.5.

Click to expand the Inherit Style section. From the Plot list, choose Optical Aberration 1.

In the Optical Aberration Diagram toolbar, click Plot.

10 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting

image to Figure 7. The remaining wavefront error (about 0.6 waves) is dominated by

spherical aberration.

Appendix — Geometry Instructions

From the File menu, choose New.

I7 | DOUBLE GAUSS LENS



NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click iw 3p.
2 Click E,/ Done.

GLOBAL DEFINITIONS

The detailed parameters of the lens can be imported from a text file. This lens is from
Ref. 1, pg 323.

Parameters |

I In the Model Builder window, under Global Definitions click Parameters I.
2 In the Settings window for Parameters, locate the Parameters section.
3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom sequence_parameters.txt.

Double Gauss Lens Parameters
The parameters that define the Double Gauss Lens geometry sequence are found in

double_gauss_lens_geom_sequence_parameters.txt. These will be described in the
tables below.

I First, define the global optical axis. This is used to orient the first lens only. The
orientation of each subsequent lens will be relative to the preceding one.

Parameter Description

nix Global optical axis, x-component
niy Global optical axis, y-component
niz Global optical axis, z-component

2 Next, define the parameters for each of the lens elements. Each lens requires 8
parameters in addition to the local optical axis definition (which, by convention, is
coincident with the local z-axis).

Parameter Description

R1_[n] Radius of curvature, surface I, lens [n]
R2_[n] Radius of curvature, surface 2, lens [n]
Tc_[n] Center thickness, lens [n]
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Parameter Description

do_[n] Outer diameter, lens [n]
di_[n] Diameter, surface |, lens [n]
d2_[n] Diameter, surface 2, lens [n]

di_clear_[n] Clear aperture diameter, surface I, lens [n]

d2_clear_[n] Clear aperture diameter, surface 2, lens [n]

3 Finally, define the remaining lens parameters.

Parameter Description

T_[n] Distance between lens elements [n] and [n+1].
do_s Stop maximum (outer) diameter

di_s Stop minimum (clear) diameter

do_D Diameter of image plane

DOUBLE GAUSS LENS GEOMETRY SEQUENCE
Start constructing the lens geometry.
I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, type Double Gauss Lens Geometry Sequence
in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

Insert the first of the Double Gauss Lens elements.

PART LIBRARIES
I In the Home toolbar, click % Windows and choose Part Libraries.

2 In the Part Libraries window, sclect Ray Optics Module>3D>Spherical Lenses>

spherical_lens_3d in the tree.
3 Click T& Add to Geometry.

4 In the Select Part Variant dialog box, select Specify clear aperture diameter in the

Select part variant list.

5 Click OK. This part is used for each of the 6 Double Gauss Lens elements.
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DOUBLE GAUSS LENS GEOMETRY SEQUENCE

Lens |

In the Model Builder window, under Component | (compl)>

Double Gauss Lens Geometry Sequence click Spherical Lens 3D | (pil).

In the Settings window for Part Instance, type Lens 1 in the Label text field.

Locate the Input Parameters scction. Click Load from File.

Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom_sequence_lensi.txt. The files

double gauss_lens_geom_sequence_lens[m,m=1..6].txt contains references to
cach of the individual lens parameters. This avoids having to enter the values manually.
Click ™ Build Selected.

Click the 'I]]= Orthographic Projection button in the Graphics toolbar.

Click the I:_f Go to ZY View button in the Graphics toolbar. Switch the view to

orthographic, and orientate the view to place the optical axis (z-axis) horizontal and the

y-axis vertical.

Create cumulative selections defining the materials, clear apertures, obstructions and

image plane that can be used within the final ray trace.

Cumulative Selections

In the Geometry toolbar, click g Selections and choose Cumulative Selections.

Lens Material |

|
2

Right-click Cumulative Selections and choose Cumulative Selection.

In the Settings window for Selection, type Lens Material 1 in the Label text field.

Lens Material 2

2

In the Model Builder window, right-click Cumulative Selections and choose

Cumulative Selection.

In the Settings window for Selection, type Lens Material 2 in the Label text field. In
the same manner, add selections for Lens Material 3, Clear Apertures,
Obstructions, Aperture Stop, and Image Plane.

Lens I (pil)
Now, apply these selections.

|
2

In the Model Builder window, click Lens I (pil).

In the Settings window for Part Instance, click to expand the Domain Selections section.
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3 In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material |

4 Click to expand the Boundary Selections section. In the table, enter the following

settings:
Name Keep Physics Contribute to
Exterior N Lens Exteriors
Surface | \ Clear Apertures
Surface 2 N Clear Apertures
Surface | obstruction S Obstructions
Surface 2 obstruction N Obstructions
Edges \ Obstructions
Lens 2

Continue constructing the lens. Add the second lens element.

I In the Geometry toolbar, click ¢ /\' Parts and choose Spherical Lens 3D.

In the Settings window for Part Instance, type Lens 2 in the Label text field.

Locate the Input Parameters scction. Click Load from File.

H W N

Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom_sequence_lens2.txt.

Each lens element can be positioned in the geometry by referencing it to an existing
work plane. For this example, use a work plane that is defined by the intersection of a
plane tangential to the optical axis with the vertex on the exit surface of the preceding
lens element.

5 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens | (pil).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_1. This is the distance

along the optical axis between the vertex on the exit surface of lens 1 and the vertex on
the entrance surface of lens 2.
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8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material 2

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior J Lens Exteriors
Surface | \ Clear Apertures
Surface 2 \/ Clear Apertures
Surface | obstruction v Obstructions
Surface 2 obstruction J Obstructions

Edges \/ Obstructions

Lens 3

The remaining lenses are similarily defined. Next, add the third lens element.
I In the Geometry toolbar, click _ Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 in the Label text field.
3 Locate the Input Parameters scction. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file

double_gauss_lens_geom_sequence_lens3.txt.

5 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens 2 (pi2).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).
7 Find the Displacement subsection. In the zw text field, type T_2.

8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material 3

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior v Lens Exteriors
Surface | \/ Clear Apertures
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Name Keep Physics Contribute to

Surface 2 N Clear Apertures
Surface | obstruction \ Obstructions
Surface 2 obstruction \ Obstructions
Edges \ Obstructions
PART LIBRARIES

Next, insert the aperture stop.

I In the Geometry toolbar, click _ Parts and choose Part Libraries.

2 In the Part Libraries window, sclect Ray Optics Module>3D>Apertures and Obstructions>

circular_planar_annulus in the tree.

3 Click &= Add to Geometry. This part is also used to define the image plane and
additional obstructions.

DOUBLE GAUSS LENS GEOMETRY SEQUENCE

Stop
I In the Model Builder window, under Component | (compl)>

Double Gauss Lens Geometry Sequence click Circular Planar Annulus | (pi4).
2 In the Settings window for Part Instance, type Stop in the Label text field.

3 Locate the Input Parameters scction. In the table, enter the following settings:

Name Expression Value Description

do do_S 60 mm Diameter, outer

dl di1_S 372 mm Diameter, inner

nix 0 0 Local optical axis, x-component
niy 0 0 Local optical axis, y-component
niz 1 I Local optical axis, z-component

4 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subscction. From the Take work plane from list, choose
Lens 3 (pi3).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type T_3+Tc_4.
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7 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
All \ Aperture Stop
Lens 4

Next, add the fourth lens element.

I In the Geometry toolbar, click ¢ _ Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 4 in the Label text field.
3 Locate the Input Parameters scction. Click Load from File.
4

Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom_sequence_lens4.txt.

5 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Stop (pi4).

6 From the Work plane list, choose Surface (wpl).

7 Find the Displacement subsection. In the zw text field, type T_4.

8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material 3

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior \/ Lens Exteriors
Surface | \/ Clear Apertures
Surface 2 \ Clear Apertures
Surface | obstruction \/ Obstructions
Surface 2 obstruction S Obstructions
Edges \/ Obstructions
Lens 5

Next, add the fifth lens element.

I In the Geometry toolbar, click ¢ _ Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 5 in the Label text field.
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3 Locate the Input Parameters scction. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom_sequence_lens5.txt.

5 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens 4 (pi5).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).
7 Find the Displacement subscction. In the zw text field, type T_5.

8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material |

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior \/ Lens Exteriors
Surface | \ Clear Apertures
Surface 2 \/ Clear Apertures
Surface | obstruction \/ Obstructions
Surface 2 obstruction \/ Obstructions
Edges \/ Obstructions
Lens 6

Add the final (sixth) lens element.

I In the Geometry toolbar, click

C _ Parts and choose Spherical Lens 3D.

2 In the Settings window for Part Instance, type Lens 6 in the Label text field.
3 Locate the Input Parameters scction. Click Load from File.
4

Browse to the model’s Application Libraries folder and double-click the file
double_gauss_lens_geom sequence_lens6.txt.

5 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens 5 (pi6).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subsection. In the zw text field, type T_6.
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8 Locate the Domain Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All v Lens Material 2

9 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior \/ Lens Exteriors
Surface | \ Clear Apertures
Surface 2 \/ Clear Apertures
Surface | obstruction \/ Obstructions
Surface 2 obstruction \/ Obstructions
Edges \/ Obstructions
Image

Now, add a surface to define the image plane.

I In the Geometry toolbar, click (- Parts and choose Circular Planar Annulus.
2 In the Settings window for Part Instance, type Image in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

do do_D 85 mm Diameter, outer

dl 0 Om Diameter, inner

nix 0 0 Local optical axis, x-component
niy 0 0 Local optical axis, y-component
niz 1 I Local optical axis, z-component

4 Locate the Position and Orientation of Output scction. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens 6 (pi7).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).
6 Find the Displacement subsection. In the zw text field, type T_7.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All y Image Plane
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8 Click [EE Build All Objects.

9 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting
image to Figure 2.
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